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1.1

Overview

Voice devices are defined by their ability to support the transmission of Voice data across
many types of networks. Voice refers to the actual data traffic being streamed across a
network for communications equipment such as phones or radios. This type of traffic can
place significant demands on a particular network, such as:

e High demands on Quality of Service for the network. Users should expect to
communicate with each other without interruption or static.

e Large amounts of data on the network as Voice calls typically last for long
periods of time. During this period, information must continually be sent.

e Users expect certain types of additional services.

Due to these demands, Voice devices can become complex to use and configure. Also,
based on the type of demands by the user, many valid configurations are used and
provide different tradeoffs to the end user. An example tradeoff would be using the
legacy guaranteed, circuit-based services versus the cost effective, packet-based VVolP
services.

Voice devices allow the user to study these types of devices accurately with a high level
of fidelity.

Intended Use

This document is intended for NETWARS users who have a reasonable level of
knowledge about voice devices and their use in voice networks. This document is written
to help the engineer learn about the configuration of these devices in NETWARS and the
types of interfaces, attributes, and statistics available in both the Discrete Event
Simulation and Capacity Planning use cases.

This document focuses on the circuit switch, VTC, and gateway aspects of the Voice
model suite. The VolP technologies (i.e., H.323 and SIP) are reserved for other
documents. For information on the H.323 models, please refer to the H.323 Models
User’s Guide. For information on the SIP protocol and models, please refer to the SIP
Models User’s Guide.



JCSS Models User’s Guide

1.2

1.3

Feature Summary

This section provides a list of the main features available in the VVoice model suite.

Table 1: Voice Features

Control Units
(MCUs)

networks.

Devices Description Support
Circuit Switch Circuit Switch Terminals provide IER traffic Supported
Terminals support only. Work with NETWARS tactical circuit

switches.
VTC Terminals VTC Terminals provide IER traffic support only. Supported
Model based on the Circuit Switch technology only.
VolIP Phones H.323 and SIP support. Phones support both IERS Supported
and Application traffic.
Tactical (Dynamic) Based on tactical circuit switch devices. Supported
Circuit Switches
PSTN (Static) Supported inside the standard OPNET models. Do | Not Supported
Circuit Switches not work with the NETWARS circuit switch models
or gateways.
Multipoint Control Allows for teleconference support with the Circuit Supported
Units (MCUs) Switch VTC terminals.
Gateways Supports the conversion between Circuit Switch, Supported
SIP, and H.323 voice technologies. Based on the
N.E.T. SHOUTip device.
SIP Proxy Server Works with the SIP protocol. Supported
H.323 Gatekeeper Based on Cisco 10S Gatekeeper. Supported
H.323 Border Border Elements will only provide basic RAS Supported
Elements (BEs) signaling and will not include the H.225 Annex G
signaling.
H.323 Multipoint Allows for teleconference support in H.323 Not Supported

Feature Description
To support the necessary Voice devices, the VVoice model suite is an extensive list of

models which include circuit switching (CS), voice/video teleconferencing (VTC), and

voice over IP (VolP) technologies. These particular technologies define the various
protocols needed to send audio and video over different types of networks. These

networks include circuit based, pipe networks, as well as, non-guaranteed, packet-based
networks (i.e., IP networks). Typically, in most networks today, a combination of these

technologies is used to provide certain quality, cost, or service to the end user.

The Voice model suite provides the ability to accurately study these network conditions
by specifying common, real-world end devices (phones), routers/switches, gateways, and

other special voice elements. To perform this task, each device contains separate

functionality which allows calls to be routed to the destination successfully. Therefore,
the configurable parameters of the VVoice devices can be divided into four main groups

namely, Circuit Switch, VTC, Gateway, and VVolIP.

OPNET Technologies, Inc.
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Limitations/Assumptions

Due to the broad spectrum of protocols available for VVoice technologies and based on the
NETWARS community needs, some modeling tradeoffs for Voice modeling have been
made. These include:

e NETWARS models tactical circuit switching technology in the circuit switch
models. This tactical environment is based off the dynamic Flood Search Routing
(FSR) protocol. This means that upon call setup, a dynamic handshake occurs
between the end phones to setup the complete circuit and reserve the necessary
voice channels on the links. No graph creation or static protocol (i.e., PSTN) is
modeled in the circuit switch models. For more information, the user can refer to
the NETWARS OPNETWORK sessions or contact the NETWARS Help Desk.

e The NETWARS circuit switch models are only able to route VVoice or VTC IERs.
These models do not support Data IERs or Application traffic.

e The NETWARS Video/Voice Teleconferencing (VTC) models only support a
pure circuit switch environment. This means that VTC calls inside NETWARS
cannot be routed between the circuit switch and VVolP technologies.

e The NETWARS SIP VolIP protocol is based off of the standard OPNET SIP
models. The NETWARS gateways work with these models to create the SIP
functionality.

Model List

The standard NETWARS model library contains a number of node models representing
various Voice devices. Those models can be located under the “Node Models” Directory
of the NETWARS_Circuit Switches, NETWARS VTC, and NETWARS VolP
palettes and include the following models.

The model names are shown with the number of ports available for each port type.

Table 2: Circuit Switch Models

Model Name Circuit Phone

Switch Switch
Definity Prologic 50 5
DNVT - 1
DPA 1 2
DPM 1 16
DSS-1, DSS-2, DSS-3 36 5
DTA 1 2
Generic Ckt Switch 32 5
Generic Telephone - 1
LEN 8 7
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NCS 16 5

REDCOM HDX 128 5

REDCOM IGX 1 Shelf 4 5

REDCOM IGX 2 Shelf 8 5

REDCOM IGX 3 Shelf 12 5

REDCOM IGX 4 Shelf 16 5

REDCOM IGX 5 Shelf 20 5

REDCOM IGX 6 Shelf 24 5

REDCOM IGX 7 Shelf 28 5

REDCOM IGX 8 Shelf 32 5

REDCOM IGX 10 Shelf 40 5

REDCOM IGX 16 Shelf 64 5

SB-3865 1 Stack 3 5

SB-3865 2 Stack 6 5

SB-3865 3 Stack 9 5

SEN 13 10

SMU 12 5

TTC-39 30 10

TTC-39A V3 16 5

TTC-39A V4 30 5

TTC-39D 28 5

TTC-39E 6 5

TTC-42 7 5

TTC-46 LEN 5

TTC-48 SEN 13 5

TTC-56 19 5

Table 3: VTC Models
Model Name Circuit Phone
Switch Switch
MCU - 1
VTC_Terminal - 1
Table 4: VolP Models
Model Name Ethernet Circuit | Circuit/Serial | ATM
Switch

VolP_Phone 1 - - -
SHOUTIp 2 8 32 -
Media_Gateway 2 8 - 2
H323 Border _Element 2 - - -
H323_ Gatekeeper 2 - - -
SIP Proxy Server 1 - - -

OPNET Technologies, Inc.




°I NH”
ki Nt Agpseations Perfirm®

1.6

1.7

Reference Documents
e SIP

e RFC 2543. “SIP: Session Initiation Protocol.” March 1999.

e RFC 3261. “SIP: Session Initiation Protocol.” June 2002.

e H.323

o “H.225.0 - Call signaling protocols and media stream packetization for packet-
based multimedia communication systems”. Version 5. International

Telecommunication Union - Telecommunication Standardization Sector (ITU-T).

e “Understanding H.323 Gatekeepers”. Cisco Systems. Document ID 5244,
http://www.cisco.com/warp/public/788/voip/understand-gatekeepers.html

Additional Information

For any additional information not provided in this document, consult the NETWARS
Model Development Guide (MDG) or other NETWARS documentation. Information
provided in the Model Development Guide includes interfacing with NETWARS models,
using NETWARS traffic types, expected packet formats and interrupts, and suggested
model development processes. This documentation is provided inside a standard
NETWARS installation and can be found in the <NETWARS Installation
Directory>\Documents directory (where <NETWARS Installation Directory> is the
directory where NETWARS is installed).

Also, for any questions regarding OPNET specific functionality, consult the standard
OPNET documentation. This documentation can be accessed inside NETWARS via the
Help > Documentation > ITGuru Documentation menu.

Finally, all Voice files can be located under the following directories and sub-directories:

e <NETWARS Installation
Directory>\Sim_Domain\op_models\netwars_std_models\circuit_switch_voic
e

e <NETWARS Installation
Directory>\Sim_Domain\op_models\netwars_std_models\voip

Note that these models and files can be accessed and modified using the OPNET Modeler
software.
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2  Configuration

One of the advantages of NETWARS is that it provides a great amount of flexibility
when configuring network and device models. As the NETWARS Voice suite of models
contains a large amount of functionality, additional steps may be needed to configure the
necessary functionality for the modeled Voice network.

2.1 Node Configuration

Currently, there are several types of Voice devices available inside the NETWARS
palette. To find the available Voice models, open the object palette (Topology > Open
Object Palette) and find the NETWARS_Circuit_Switches, NETWARS_VTC, and
NETWARS_VolIP palettes (shown below).

Object Palette Tree: voice_devices-baseline — | | |i|
| Search by name: Eind Mext

Drag model or subneticon into workspace

'\[ MNanay SPAWAR Models Read-only :I
{§ NETWARS Standard Modsls  Default, Read-only
] Fiead-onl
Eead-onl ||
NETWARS_DAMA Reac-only

NETWARS_Encryption_Dewvices  Read-only

NETWARS_GBS Read-only
NETWARS_Generic_Terminals  Read-only
NETWARS_IP_Data Read-only
NETWARS_Link16 Read-only
MNETWARS_Links Read-only
NETWARS_Multiplexers Read-only
NETWARS_Radio_Systems Read-only
NETWARS_Satellite_Stations Read-only
NETWARS_Terrestial Read-only
= | P Y e e ) e " ! L =l I

Fead-only
Eead-only

Node Mudels
= MCL Fixed Mode  Generic Fhone
. YWTC Terminal  Fixed Node  Generic Fhone

- Mewbndge
1 Morel

Logical Subnet

<1 pricing

1 routers 2
< ¥

[T Create right-angled link

lodel Details | Create Custom Model...l Close | Help

Figure 1: Available Voice Nodes

Once the particular VVoice model is found, you can drag and drop the model into the
scenario to successfully deploy the model. Once the model is deployed, attributes are
available on the device which can be modified to activate certain Voice specific
functionality. The following subsections discuss these specific Voice attributes.

OPNET Technologies, Inc.



..............

2.1.1 Circuit Switch Device Attributes

The Circuit Switch device attributes are all of the attributes which can be accessed by
right-clicking on a Circuit Switch device and selecting the Edit Attributes menu. The
following sections describe the node attributes for each type of device in detail. Any
attributes which are not included inside the tables (i.e., “Applications”, “CPU”, etc.) refer
to OPNET standard attributes. Please refer to the OPNET documentation for further
details on these attributes.

2111 Circuit Switch Terminal Parameters

These parameters refer to any node attributes which are assigned to the Circuit Switch
terminals. Circuit Switch terminals are devices which act as end stations (i.e., phones)
inside the Circuit Switch network. Example devices which fall under this specification
are the DNVT and Generic Telephone models. The following table illustrates the
attributes with descriptions needed to properly configure the Circuit Switch terminals.

_|o|x]
Type:lworkstation
| Aftribute | Yalue d
@ rname .

Applications
CPU

k- Call Bandwicith 64 Kbps

- Call Type WOICE
@ |Client Address Auto Assigned
@ I—GatewaySpecification Auto Assigned
@ | availability_status enabled

|- classification Unclassified
@ Fequipment_type Phane

@ |max_active_calls 1
Free-text Questions [

[ ]

I~ Apply changes to selected ohjects [~ Advanced

I Find Mext | QK Cancel |

Figure 2: Circuit Switch Terminal Parameters
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Table 5: Circuit Switch Terminal Parameters

Attributes

Description

Call Bandwidth

This attribute specifies the bandwidth (in bps) which will be required for each
voice call that uses this terminal (as a source or destination terminal). When a
voice call is being setup, all voice channels along the route of the call must
support the bandwidth which is specified by this attribute. If so, then any
available voice channels on the links will be reserved for the duration of the
call. If not, then the voice call will be failed due to a lack of bandwidth. In
cases where the source and destination terminals have different call
bandwidth values, the lower value of the two terminals will be used. The
default value is 64 Kbps.

Call Type

This attribute specifies the type of call which will be accepted by this terminal
during simulation. If the value is set to “VOICE,” then only Voice IERs will
be able to use this terminal. If the value is set to “VTC,” then only VTC IERs
will be able to use this terminal. The default for this attribute is the “VOICE”
value and should not be changed.

Gateway Specification

This attribute specifies the gateway this phone will signal if the destination
circuit switch terminal cannot be found. If a gateway exists in the network,
the hierarchical name of that gateway will be available as an option for this
attribute. If the user selects the “Auto Assigned” option, the circuit switch
terminal will dynamically lookup all gateways available in the simulation and
will randomly pick a gateway. The default for this attribute is the “Auto
Assigned” value.

Max Active Calls

This attribute specifies the maximum number of simultaneous calls on this
circuit switch terminal. This allows the terminal to act as several terminals
instead of having the user deploy many terminals into the scenario. The
default for this attribute is ‘1’ meaning that this terminal will act as a single
terminal.

Availability Status

A NETWARS standard attribute, denotes whether the node is available to
receive IER traffic during a simulation.

Classification

A NETWARS standard attribute, sets the classification level (i.e.,
Unclassified, Classified, etc.) of this particular circuit switch terminal.

Equipment Type

A NETWARS standard attribute, sets the device type for NETWARS specific
functionality. This attribute should always be set to “Phone.”

21.1.2 Circuit Switch Parameters

These parameters refer to any node attributes which are assigned to the Circuit Switch
devices. Circuit Switch devices are devices which act as switches (i.e., switch/routers)
inside the Circuit Switch network. Example devices which fall under this specification
are the LEN, SEN, and TTC-39 models. The following table illustrates the attributes
with descriptions needed to properly configure the Circuit Switch devices.

OPNET Technologies, Inc.




_Ioix]
| Adtribute | Walue ;I
@ rname
@ FMSE Topology Mask include
l—availability_status promoted
|- classification Unclassified
@ Fequipment_type Switch, Router
Free-text Questions ]
=
I~ Apply changes to selected ohjects [~ Advanced
[ EindNext | oK Cancel |

Figure 3: Circuit Switch Parameters

Table 6: Circuit Switch Parameters

ations Perform®

Attributes

Description

MSE Topology Mask

This attribute specifies that this device should be included inside the Circuit
Switch network. This attribute should always be set to “include.”

Availability Status

A NETWARS standard attribute, denotes whether the node is available to
receive IER traffic during a simulation.

Classification

A NETWARS standard attribute, sets the classification level (i.e.,
Unclassified, Classified, etc.) of this particular circuit switch device.

Equipment Type

A NETWARS standard attribute, sets the device type for NETWARS specific
functionality. This attribute should always be set to “Switch, Router.”
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2.1.2 VTC Device Attributes

The VTC device attributes are all of the attributes which can be accessed by right-
clicking on a VTC device and selecting the Edit Attributes menu. VTC devices are
devices which act as VTC end stations (i.e., terminals) inside the Circuit Switch network.
Example devices which fall under this specification are the VTC_Terminal and MCU
models. The following table illustrates the attributes with descriptions needed to properly
configure the VTC devices.

Note that as the VTC devices are based on the NETWARS Circuit Switch models, these
type of models are deployed with other circuit switch devices (such as circuit switches).
To configure the circuit switch models, refer to the section above.

Any attributes which are not included inside the tables (i.e., “Applications”, “CPU”, etc.)
refer to OPNET standard attributes. Please refer to the OPNET documentation for further
details on these attributes.

== {¥TC_Terminal} Attributes _ | | |i|

Type:lworkstatiun

|Attribute

@ rname
Applications
CPU

|- Call Bandwidth 384 Khps
FCall Type WTC
)] I—CIientAddress Auto Assigned
@ | Gatewsy Specification Auto Assigned
@ | availability_status enabled
l—c:lassification Unclassified
@ Fequipment_type WTC Terminal

@ Fmax_active_calls 1
Free-text Questions [

[]

[~ Apply changes to selected objects [~ Advanced

I Find Mext | QK Cancel |

Figure 4: VTC Device Parameters

OPNET Technologies, Inc.
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Table 7: VTC Device Parameters

Attributes

Description

Call Bandwidth

This attribute specifies the bandwidth (in bps) which will be required for each
VTC call that uses this terminal (as a source or destination terminal). When a
VTC call is being setup, all voice channels along the route of the call must
support the bandwidth which is specified by this attribute. If so, then any
available voice channels on the links will be reserved for the duration of the
call. If not, then the voice call will be failed due to a lack of bandwidth. In
cases where the source and destination terminals have different call bandwidth
values, the lower value of the two VTC terminals will be used. The default
value is 384 Kbps.

Call Type

This attribute specifies the type of call which will be accepted by this terminal
during simulation. If the value is set to “VOICE,” then only Voice IERs will
be able to use this terminal. If the value is set to “VTC,” then only VTC IERs
will be able to use this terminal. The default for this attribute is the “VTC”
value and should not be changed.

Gateway Specification

This attribute specifies the gateway this VTC terminal will signal if the
destination VTC terminal cannot be found. If a gateway exists in the network,
the hierarchical name of that gateway will be available as an option for this
attribute. If the user selects the “Auto Assigned” option, the VTC terminal will
dynamically lookup all gateways available in the simulation and will randomly
pick a gateway. The default for this attribute is the “Auto Assigned” value.

Max Active Calls

This attribute specifies the maximum number of simultaneous calls on this
VTC terminal. This allows the terminal to act as several terminals instead of
having the user deploy many terminals into the scenario. The default for this
attribute is ‘1’ meaning that this terminal will act as a single terminal.

Availability Status

A NETWARS standard attribute, denotes whether the node is available to
receive IER traffic during a simulation.

Classification

A NETWARS standard attribute, sets the classification level (i.e., Unclassified,
Classified, etc.) of this particular VTC terminal.

Equipment Type

A NETWARS standard attribute, sets the device type for NETWARS specific
functionality. This attribute should always be set to “VVTC Terminal.”

11
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2.1.3 VolP Device Attributes

The VoIP device attributes are all of the attributes which can be accessed by right-
clicking on a VVolP device and selecting the Edit Attributes menu. The following
sections describe the node attributes for each type of device in detail. Any attributes
which are not included inside the tables (i.e., “Applications”, “CPU”, etc.) refer to
OPNET standard attributes. Please refer to the OPNET documentation for further details
on these attributes.

2131 VolP Phone Attributes

The following table describes the VVoIP Phone node attributes in detail. Any relevant
compound node attributes are left for subsequent tables as compound attributes contain
another layer of attributes. All other attributes refer to the routing capabilities of this
H.323 terminal and are out of scope for this document.

] tvo1P_Phone) Attributes — O] x|

Type: |w0rkstation

|Attribute
@ r~name

H3z3

CFU

“olP Phone
& |Client Address Auto Assigned

OHCF

IF Routing Protocols

Repors

Ethermet

IP bulticasting

P

Security
® [ Mainframe Parameters Mot Configured

MHREF

REWE

SIF

Servers

TCF

b arvailability_status anabled

|- classification Unclassified
@ Fequipment_type Phone s

Free-text Questions ] -
o o
[~ Apply changes to selected ohjects [~ Advanced

| Eind Mext | oK I Cancel |

Figure 5: VolP Phone Node Attributes

OPNET Technologies, Inc.
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Table 8: VolP Phone Node Attributes

Attributes Description

Availability Status A NETWARS standard attribute, denotes whether the node is available to
receive IER traffic during a simulation.

Classification A NETWARS standard attribute, sets the classification level (i.e.,
Unclassified, Classified, etc.) of this particular \VoIP phone.

Equipment Type A NETWARS standard attribute, sets the device type for NETWARS specific
functionality. This attribute should always be set to “Phone.”

VolP Phone Parameters

As the VolP_Phone node model allows configuration of both H.323 and SIP protocol
voice calls, the VolIP Phone compound attribute was added so the user could configure
attributes which would apply to both protocols. The following table illustrates the
attributes with descriptions needed to properly configure the VolP_Phone device.

(UoIP_Phone) Attributes _ | O |£I

Type: |w0rkstation

|Attribute |Value =
@ rname “olP_Phone
H3z23
CRU
“'olP Phone
&  |FCallMode Use Woice Config Setting
3] |-Encoder Scheme Use Woice Config Setting
@ |Gateway Specification Auto Assigned
@ I—Hybrid tMode Use Woice Config Setting
@ FMaxNumber of Calls Unlimited
ol Protocal SIP
&  Lvoice Frames per Packet Use Woice Config Setting
@ |Client Address Auto Assighed
DHCF
|IP Routing Protocols
Reports

Etheret o
IP tulticasting

P

SEecurity
& E Mainframe Parameters Mat Canfigured

MHREF

RSP -
. o
[~ Apply changes to selected objects [~ Advanced

| Find Maxt | oK I Cancal |

Figure 6: VolP Phone Compound Attribute Parameters
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Table 9: VolP Phone Compound Attribute Parameters

Attributes

Description

Call Mode

This attribute specifies the different call modes which are available on the
VolIP Phone. If the user selects “Signaling and Data,” then both the VolP
protocol call signaling and the voice data packets will traverse the network.
If the user selects “Signaling Only,” then only the VolIP protocol call
signaling will occur. In this case, no voice data packets will be sent. If the
user selects “Use Voice Config Setting,” then this VVoIP Phone will use the
setting for the matching attribute located in the Voice Config node. Note
that the Voice Config node is located in the Configuration OPFAC.

Encoder Scheme

This attribute specifies the encoder scheme which will be used for all calls
which use this particular VolIP Phone. The encoder scheme specifies the
information about the voice data packets sent during the call. Such
information includes packet intervals and packet size. The available
encoder schemes are based on standard VVolP phone technologies. If the
user selects “Use Voice Config Setting,” then this VVoIP Phone will use the
setting for the matching attribute located in the Voice Config node. Note
that the Voice Config node is located in the Configuration OPFAC.

Gateway Specification

This attribute specifies the gateway this phone will signal if the destination
VolP phone cannot be found. If a gateway exists in the network, the
hierarchical name of that gateway will be available as an option for this
attribute. If the user selects the “Auto Assigned” option, the VolP phone
will dynamically lookup all gateways available in the simulation and will
randomly pick a gateway.

Hybrid Mode

This attribute allows the user to choose between the use of hybrid or explicit
voice data packets during a simulation. If the user chooses the “Hybrid
Packets” option, the VolP phone will load the network using hybrid packets
for all voice data packets. This option will increase the speed of the
simulation with the tradeoff of losing some statistics (such as jitter and end-
to-end delay). If the user picks the “Explicit Packets” option, the VolP
Phone will load the network using an explicit packet for each voice data
packet. This slows the simulation down but provides a detailed analysis. If
the user selects “Use Voice Config Setting,” then this VolP Phone will use
the setting for the matching attribute located in the Voice Config node.
Note that the VVoice Config node is located in the Configuration OPFAC.

Max Number of Calls

This attribute specifies the maximum number of simultaneous calls on this
VolIP Phone. This allows the phone to act as several phones instead of
having the user deploy many phones onto the scenario. If the user selects
the “Unlimited” option, there is no limit to the number of calls placed on the
VolIP phone at a single time.

VolIP Protocol

This attribute specifies the call signaling protocol which will be used to
setup/teardown a voice call on this phone. If this attribute is set to “SIP,”
the calling signaling protocol will be the Session Initiation Protocol (SIP).
If the attribute is set to “H.323,” the protocol used will be the H.323
umbrella protocol.

Voice Frames per Packet

This attribute specifies the number of voice frames per packet. This
attribute coincides with the encoder scheme attribute above and further
specifies information about the voice data packet. This attribute affects the
amount of data which is included inside a voice data packet. If the user
selects “Use Voice Config Setting,” then this VVoIP Phone will use the
setting for the matching attribute located in the VVoice Config node. Note
that the Voice Config node is located in the Configuration OPFAC.

OPNET Technologies, Inc.
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SIP and H.323 Parameters

As the VolP_Phone node model allows configuration of both H.323 and SIP protocol
voice calls, additional compound attributes are needed to configure these protocols
(shown below). However, as these attributes are based on protocol standards, these
attributes are out of scope for this document.

For information on how to configure the SIP protocol, please refer to the SIP Models
User’s Guide.

For information on how to configure the H.323 protocol, please refer to the H.323
Models User’s Guide.

(UoIP_Phone) Attributes _ | O |i|

Type: |w0rkstation

|Attribute |Value =
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Figure 7: VoIP Phone SIP and H.323 Parameters
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2.1.3.2

2.1.4

Other VolP Device Attributes

As all the other models inside the NETWARS VolIP suite are specific to the H.323 and
SIP protocols, these models (i.e., the H323 _Border_Element, H323 Gatekeeper, and
SIP Proxy Server models) are out of scope for this document.

For information on how to configure the SIP protocol, please refer to the SIP Models
User’s Guide.

For information on how to configure the H.323 protocol, please refer to the H.323
Models User’s Guide.

Gateway Device Attributes

The Gateway device attributes are all of the attributes which can be accessed by right-
clicking on the Media_Gateway or SHOUTIp devices and selecting the Edit Attributes
menu. The following table describes the node attributes in detail. Any relevant
compound node attributes are left for subsequent tables as compound attributes contain
another layer of attributes. All other attributes refer to the routing capabilities of this
gateway and are out of scope for this document. Please refer to the standard OPNET
documentation for more information.

OPNET Technologies, Inc.
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Figure 8: Gateway Attributes

Table 10: Gateway Attributes

Attribute Description

Availability Status A NETWARS standard attribute, denotes whether the node is available to receive
IER traffic during a simulation.

Classification A NETWARS standard attribute, sets the classification level (i.e., Unclassified,
Classified, etc.) of this particular gateway.

Equipment Type A NETWARS standard attribute, sets the device type for NETWARS specific
functionality. This attribute should always be set to “Media Gateway.”
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2141

Media Gateway or SHOUTIip Parameters

As the Media_Gateway or SHOUTip node models allow configuration of both H.323
and SIP protocol voice calls, the Media Gateway or SHOUTip compound attributes
were added so the user could configure attributes which would apply to both protocols.
The following table illustrates the attributes with descriptions needed to properly
configure the gateway.

{SHOUTip) Attributes

Type:| SHOUTip

=o]x]

|Attribute
@ rname
Security
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H323
WEMN
IF Fiouting Protocals
Reparts
CFU
SHOUTip
I Call Made

|Value ;I
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Lwoice Frames per Packet Use “oice Config Setting
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IP Multicasting ﬂ
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EEREEIE

[~ Apply changes to selected objects

—

Figure 9: Media Gateway or SHOUTip Parameters
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Table 11: Media Gateway or SHOUTip Parameters

Attributes

Description

Call Mode

This attribute specifies the different call modes which are available on the gateway. If
the user selects “Signaling and Data,” then both the VolIP call signaling and the voice
data packets will traverse the network. If the user selects “Signaling Only,” then only
the VVolP call signaling will occur. In this case, no voice data packets will be sent. If
the user selects “Use Voice Config Setting,” then this gateway will use the setting for
the matching attribute located in the Voice Config node. Note that the Voice Config
node is located in the Configuration OPFAC.

Encoder Scheme

This attribute specifies the encoder scheme which will be used for all calls which use
this particular gateway. The encoder scheme specifies the information about the voice
data packets sent during the call. Such information includes packet intervals and
packet size. The available encoder schemes are based on standard gateway
technologies. If the user selects “Use Voice Config Setting,” then this gateway will
use the setting for the matching attribute located in the Voice Config node. Note that
the Voice Config node is located in the Configuration OPFAC.

Hybrid Mode

This attribute allows the user to choose between the use of hybrid or explicit voice data
packets during a simulation. If the user chooses the “Hybrid Packets” option, the
gateway will load the network using hybrid packets for all voice data packets. This

OPNET Technologies, Inc.
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2.14.2

option will increase the speed of the simulation with the tradeoff of losing some
statistics (such as jitter and end-to-end delay). If the user picks the “Explicit Packets”
option, the gateway will load the network using an explicit packet for each voice data
packet. This slows the simulation down but provides a detailed analysis. If the user
selects “Use Voice Config Setting,” then this gateway will use the setting for the
matching attribute located in the Voice Config node. Note that the Voice Config node
is located in the Configuration OPFAC.

SHOUTip
Network Protocol

This attribute specifies the call signaling protocol which will be used to
setup/teardown a voice call on this gateway. If this attribute is set to “SIP,” the calling
signaling protocol will be the Session Initiation Protocol (SIP). If the attribute is set to
“H.323,” the protocol used will be the H.323 umbrella protocol.

Voice Frames per
Packet

This attribute specifies the number of voice frames per packet. This attribute coincides
with the encoder scheme attribute above and further specifies information about the
voice data packet. This attribute affects the amount of data which is included inside a
voice data packet. If the user selects “Use Voice Config Setting,” then this gateway
will use the setting for the matching attribute located in the VVoice Config node. Note
that the VVoice Config node is located in the Configuration OPFAC.

SIP and H.323 Parameters

As the Media_Gateway or SHOUTip node models allow configuration of both H.323
and SIP protocol voice calls, additional compound attributes are needed to configure
these protocols (shown below). However, as these attributes are based on protocol
standards, these attributes are out of scope for this document.

For information on how to configure the SIP protocol, please refer to the SIP Models

User’s Guide.

For information on how to configure the H.323 protocol, please refer to the H.323
Models User’s Guide.
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2.2
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Figure 10: Gateway SIP and H.323 Parameters

Link Configuration

As the Voice devices are used in conjunction with the several types of networks, these
devices contain many different types of ports. Therefore, the link possibilities for these
devices are not limited to a single technology. Currently, there are two ways to deploy
links inside NETWARS:

1. Link Deployment Wizard (Topology > Link Operations > Deploy Link or Ctrl +
L)

2. Object Palette (Topology > Open Object Palette)

Currently, the easiest way to connect a VVoice device is to use the Link Deployment
Wizard (LDW). To accomplish a successful configuration, use the following steps (see
the matching LDW figure below):

1. Select the two devices which need to be connected and press Ctrl + L.

OPNET Technologies, Inc. 20
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2. When the Link Deployment Wizard appears, select an available link technology from
the menu (if an error message appears, the Voice device is unable to connect to this
type of device).

3. Select the link which is appropriate for this technology. For example, if the specified
technology is Ethernet then the 10BaseT, 100BaseT, and 1000BaseT links are
available. The following list shows the applicable technologies for each type of
device:

a. Circuit Switch Terminals: Phone Switch links

b. Circuit Switch Devices: Circuit Switch and Phone Switch links

c. VTC Devices: Phone Switch links

d. VolIP Phone and Devices: Ethernet (10BaseT, 100BaseT, and 1000BaseT) links

e. Gateway: Circuit Switch, Ethernet (10BaseT, 100BaseT, and 1000BaseT), ATM
(SONET OC1, SONET OC3, SONET OC12, etc.), and Circuit/Serial links

4. Check to make sure the ports on both the connecting devices are acceptable.
NETWARS contains a certain naming convention which will be placed on ports
which correspond to certain link types. The following list shows the applicable links
with the matching port naming convention.

a. Phone Switch (ckt_pt_#)

b. Circuit Switch (dtg_pt_# or cs_pt_#)
c. Ethernet (eth_tx_# #)

d. ATM (atm_tx_# #)

e. Circuit/Serial (cir_pt_#)

5. Change the bandwidth on the link. Selecting an initial link (i.e., 10BaseT, 100BaseT,
etc.) will set a default bandwidth in the wizard but you can select other bandwidth
values as necessary.
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2.3

2.3.1

=E Select Wired Link Properties ;Iglil
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Figure 11: Link Deployment Wizard

Refer to the NETWARS User’s Manual for further information on deploying links using
the above methods.

Voice Channel Configuration

The circuit switch models in NETWARS provide the ability to configure voice channels
on circuit switch links. Voice channels are used by the circuit switch models to reserve
the necessary bandwidth on link for a particular voice call. For each circuit switch link
on the path from the source phone to the destination phone, there must be a voice channel
available with at least the same amount of bandwidth as the voice call. Note that voice
channels can be reserved for both Voice and VTC calls (IERS).

To configure voice channels inside NETWARS, the user must modify the characteristics
of the links. Depending on whether the link is a Circuit Switch or Phone Switch link, the
process is different. Shown below are the steps necessary to configure voice channels on
each type of link.

Configuring Voice Channels on Circuit Switch Links

Typically, Circuit Switch links are the links defined between circuit switch devices (i.e.,
LEN, SEN, TTC-39, etc.). Also, the Circuit Switch link is used when connecting a
circuit switch device to a gateway. To modify the voice channels on these links, use the
following steps:

1. Right-click on the Circuit Switch link and select Edit NETWARS Attributes.

OPNET Technologies, Inc.
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Figure 12: Editing Circuit Switch Link Attributes

2. When the Wired Link Attributes dialog box appears, modify the Number of Voice
Channels and Channel Size for Voice attributes. The Number of VVoice Channels
attribute will specify the number of simultaneous calls which can be present on that
link. The Channel Size for Voice attribute will specify the size (in Kbps) of each
voice channel on that particular link. For a voice call to use an available channel
during simulation, the Channel Size for Voice attribute must be at least equal in size
to the Call Bandwidth attribute on the Circuit Switch or VTC phone. In cases where
VTC is used, the Call Bandwidth can be spread across six different channels. Note
that the Remaining Data Bandwidth attribute shows the remaining bandwidth
available on the link. This is calculated by taking the total bandwidth of the link and
subtracting the bandwidth used for each voice channel (i.e., Remaining Bandwidth
= Total Bandwidth — (Number of VVoice Channels * Voice Channel Size)). The
remaining bandwidth value should never be a negative value.

3. Click OK on the dialog box to accept the changes.
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Figure 13: Setting Voice Channels on Circuit Switch Links

2.3.2 Configuring Voice Channels on Phone Switch Links

Phone Switch links are the links defined between a circuit switch device (i.e., LEN, SEN,
TTC-39, etc.) and a circuit switch or VTC terminal (i.e., DNVT, VTC_Terminal, etc.).
As this link is always connecting a single end terminal to the border circuit switch device,
this link should always have the same number of voice channels as the amount specified
by the phone. In typical cases, an end terminal would only have a single voice channel
going out on the link connecting it to the circuit switch network. However, in
NETWARS, an end terminal can represent many end terminals (so the user does not have
to deploy several terminal devices into a scenario). Therefore, to avoid mis-
configuration, the Phone Switch link will use the same number of voice channels as the
number of users on the phone. To modify the voice channels on these links, use the
following steps:

1. Right-click on the end terminal (i.e., a DNVT, VTC_Terminal, etc.) connecting to
the Phone Switch link and select Edit Attributes.

OPNET Technologies, Inc.

24



Scenario Builder: voice_devices Scenario: baseline [Subnet: top.Nw_Top]

[g-— --_-|,-|+|.'g‘ =||::Fns|- ol B sl |“|

dhwt (contents) »
7 Be oot W Edit Attributes

Figure 14: Selecting Phone Switch Link Attributes

2. When the Edit Attributes dialog box appears, modify the Call Bandwidth and Max
Active Calls attributes. The Call Bandwidth attribute will specify the size (in Kbps)
of each voice call which uses that particular end terminal. Note that during a
simulation, the lower Call Bandwidth between the source and destination terminals
will be used when reserving voice channels. The Max Active Calls attribute will
specify the number of simultaneous calls which can be present on that end terminal.

3. Click OK on the dialog box to accept the changes.
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Figure 15: Editing Phone Switch Link Attributes

4. Once the end terminal attributes have been changed for the link, right-click on the
Phone Switch link and select Edit NETWARS Attributes. When the Wired Link
Attributes dialog box appears, the user can validate the changes made in Steps 2 and
3. The Number of Voice Channels attribute will correspond to the Max Active
Calls attribute. The Channel Size for Voice attribute will correspond to the Call
Bandwidth attribute on the Circuit Switch or VTC phone. In cases where VTC is
used, the Call Bandwidth can be spread across six different channels. Note that the
Remaining Data Bandwidth attribute shows the remaining bandwidth available on
the link. This is calculated by taking the total bandwidth of the link and subtracting
the bandwidth used for each voice channel (i.e., Remaining Bandwidth = Total
Bandwidth — (Number of Voice Channels * Voice Channel Size)). The remaining
bandwidth value should never be a negative value.

Note that the attributes inside the Wired Link Attributes dialog box cannot be
modified. The user must always change the end terminal configuration to change the
voice channels on this link. Again, this is by design and avoids mis-configuration
inside the scenario.

OPNET Technologies, Inc.



.............

T

MName: | FAAD4001

Type: I phone_switch LI

Classification: [Unciassitied ~|

Bandwidth: {10000.00 Kbps

len.Src For Ickt_pt_15

dend Dot Port !m L trancmiter

Mumber of Yoice Channels: |1

Channel Size for Vaoice: |54-DU Khps

Remaining Data Bandwidth: 9975 00 Kbps
Becompute |

Dptimization Attributesl Eailure,-"Recoveryl

¥ Include External Muxes for SLD

Edit SLD Namel oK I Cancel |

Figure 16: Setting Voice Channels on Phone Switch Links

2.3.3 Matching Encoder Schemes to Voice Channels

When configuring a scenario which contains calls that transfer between the Circuit
Switch and VolP domains, the user should be aware of the Encoder Scheme attribute.
This attribute is placed on the VVolP phone and specifies the information about the voice
data packets sent during the call on the IP network. However, when converting between
a VolIP and Circuit Switch network, the gateway must be able to translate the voice
packets on the IP network into the same amount of data on the voice channel (or vice
versa). Therefore, a translation is made between the encoder scheme used on the VVolP
phone and the voice channel connected into the gateway during call setup. The following
list shows the available encoder schemes for the VVolP technology and the matching
bandwidth which will be reserved inside the Circuit Switch network (in Kbps).

e G.711 - 64 Kbps

e (G.711 (Silence Suppression Enabled) — 64 Kbps

e (.723.1-24 Kbps

e (.723.1 (Silence Suppression Enabled) — 24 Kbps

e (G.726 ADPCM - 32 Kbps

e (.726 ADPCM (Silence Suppression Enabled) — 32 Kbps
o (G.727 - 32 Kbps

e (.727 (Silence Suppression Enabled) — 32 Kbps
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e (.729 CS-ACELP -8 Kbps
e (.729 CS-ACELP (Silence Suppression Enabled) — 8 Kbps

Note that if the voice channels inside the Circuit Switch network are not large enough to
handle the VolP call, then the call will fail during setup (as the voice channels cannot be
fully reserved). Conversely, if the IP network cannot handle the amount of packets
created from the Circuit Switch call, the call will setup but will eventually fail when the
quality of service reaches a certain limit.
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Figure 17: Setting the Encoder Scheme Attribute
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Usage

The Voice suite of models allows the user to model networks which work with both
Discrete Event Simulations and Capacity Planner in NETWARS. Based on the network
required, there are several types of Voice devices which provide the necessary
functionality. Various types of statistics measure the performance in the Node, Port, or
Global level. The figure below shows a simple example network with VVoice devices.
This example network shows the user a simple setup which can be used to help
understand the basics of Voice modeling. Also, the example is intended to demonstrate
some of the functionality which is explained in the later sections of this document.

The scenario shown below is a common scenario which includes a Circuit Switch
network connected, through a Promina backbone, to a VoIP (H.323) Network. To
recreate the scenario, use the following steps:

1. Create a new NETWARS project (File > New Project...).

2. Create two OPFACs in the scenario by right-clicking in the workspace and selecting
Create New OPFAC. Rename the OPFACs to “Circuit_Switch_Network” and
“VolP_Network” by right-clicking on a created OPFAC and selecting Edit
Attributes.

3. Drill into the “Circuit_Switch_Network” OPFAC (by double clicking on the OPFAC)
and deploy 3 LEN, 2 DNVT, and 1 Promina devices using the Object Palette
(Topology > Open Object Palette). The layout should look similar to the “View of
the Circuit_Switch_Network OPFAC” figure below (minus the links).

4. Deploy links between the different devices in the scenario using the Link Deployment
Wizard. To do this, select two devices and press Ctrl + L. Use the default settings
when the wizard appears. The layout should look similar to the “View of the
Circuit_Switch_Network OPFAC” figure below.

5. Right-click into the workspace and select Return to Parent Organization.

6. Drill into the “VolP_Network” OPFAC (by double clicking on the OPFAC) and
deploy 3 Cisco_4500, 2 VolP_Phone, 1 SHOUTIp, 1 len, and 1 Promina devices
using the Object Palette (Topology > Open Object Palette). The layout should look
similar to the “View of the VolP_Network OPFAC” figure below minus the links.

7. Deploy links between the different devices in the scenario using the Link Deployment
Wizard. To do this, select two devices and press Ctrl + L. Use the default settings
when the wizard appears. The layout should look similar to the “View of the
VolP_Network OPFAC” figure below.

8. For each VolIP Phone inside the “VolP_Network OPFAC, change the VoIP Phone >
VolP Protocol attribute to the H.323 value. To do this, right-click on the device and
select Edit Attributes.
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10.

11.

12.

13.

For the SHOUTIp device inside the “VolP_Network” OPFAC, change the SHOUTIp
> SHOUTIip Network Protocol attribute to the H.323 value. To do this, right-click
on the device and select Edit Attributes.

Right-click into the workspace and select Return to Parent Organization.

Select the two OPFACs in the scenario and use the Link Deployment Wizard to
deploy a link between the two Promina devices.

Select the two OPFACs in the scenario and use the Generic Circuit Wizard (Ctrl + D)
to connect a circuit between the Promina devices. Use the defaults for the circuit
when the wizard appears.

Specify two IERs inside the scenario by using the Traffic > IERs > Specify IERS
menu. The two IERs should have the following attributes:

e |ER #1: Producer (Circuit_Switch_Network), Consumer (VolP_Network),
Traffic Type (Voice), Size (20), Average Interarrival (100), Distribution Type
(CONSTANT).

e |ER #2: Producer (VolP_Network), Consumer (Circuit_Switch_Network),
Traffic Type (Voice), Size (50), Average Interarrival (60), Distribution Type
(CONSTANT).

OPNET Technologies, Inc.
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Scenatio Builder: Erample_Yoice_Scenario Scenario: baseline [Subnet: top.Nw_Top.Circuit_Switch_Network]

FELEERE

Figure 19: View of the Circuit_Switch_Network OPFAC

OPNET Technologies, Inc.
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3.1 Capacity Planning Reports

The Capacity Planner is a tool which allows you to quickly study a network by
analytically calculating the performance. This provides you with a large amount of
studies such as failure, configuration, and capacity studies. Inside NETWARS, the
Capacity Planner tool has been enhanced to generate web reports. The web reports shown
below are helpful when looking at the VVoice devices. The numbers and statistics inside
the web report examples are based on Capacity Planner runs using the example project
shown above.

To run Capacity Planner on a network, click the Capacity Planning > Evaluate... menu
after opening a particular NETWARS scenario. Refer to the NETWARS documentation
for more information regarding how to use the Capacity Planner tool.

Once the Capacity Planner tool is run, the links in the network will be color-coded (to
show utilization) and a web report will be shown displaying the results from the analysis.
There are two parts of the web report which are specific to Voice devices (the other parts
can be utilized but are not in the scope of this document). The first report is the
Executive Summary portion of the report. This is the first page that displays after the
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Capacity Planner tool has finished. This report discusses an overall view of the network
and gives you high level points so that the user can easily narrow down problems areas.

Inside the Executive Summary is a section titled Link Utilization. This section shows the
link with the maximum utilization out of all the links inside the scenario. This gives the
user a quick insight on whether there are any bottlenecks (i.e., over utilized links) inside
the network. Secondly, the section titled Traffic Performance is useful in making sure
that all Traffic instances (IERs or Applications) have been routed successfully inside the
network. A successful route of a traffic instance is based purely on the graph
connectivity between the source and destination phones. Finally, the section titled
Circuit Performance is useful in determining whether any circuit instances in the
network were configured properly. In the case of VVoice models, this section will not
typically be used. However, in the example scenario above, a Promina circuit was
created to bridge the Circuit Switch and IP networks.

It is important to note that the Capacity Planner will route traffic based on graph
connectivity. In the case of the Voice models, the Capacity Planner will look at the voice
channels available, IP connectivity, and whether circuits were deployed inside the
network. The Capacity Planner will then route traffic based on the shortest path in the
graph from the source to the destination. This means that certain protocols will not be
used (such as IP, H.323, SIP, etc.) to route traffic inside Capacity Planner. For a more
detailed analysis of voice calls with these protocols, the user should run the Discrete
Event Simulation (DES). However, Capacity Planner will show the user several
important metrics before investing time in running DES which can take much longer
periods of time to finish. Please refer to the NETWARS documentation for more details
on Capacity Planner.

OPNET Technologies, Inc.
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Figure 21: Capacity Planning Report Executive Summary

The Link Utilization Report is another section inside the Capacity Planning web report.
This section can be accessed by clicking on the hyperlink located on the left side of the
Capacity Planning report. The Link Utilization report shows a complete list of links
inside the network. It provides a quick way of seeing all of the utilization numbers for
each link inside the network. This allows you to easily debug any problems where traffic
is could be providing a bottleneck to a particular link. This is also a continuation of the
Executive Summary which only showed the link with the maximum utilization. Also,
much of the data displayed is shown in hyperlink form so the user can click the necessary
object in the report and the Scenario Builder will display the relevant link. The user can
then check the necessary attributes or devices to look for configuration issues. Note that
the rows in the report are color-coded to represent the utilization of the link (blue is zero,
green is low, yellow is medium, and red is high utilization).
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Figure 22: Capacity Planning Link Utilization Report

The Traffic Route Report is another section inside the Capacity Planning web report.
Similar to the Link Utilization Report, this section can be accessed by clicking on the
hyperlink located on the left side of the Capacity Planning report. The Traffic Route
Report provides the ability to look at the different instances of traffic inside the scenario.
This report is important for looking at where the traffic was being routed, how the traffic
was defined, whether the traffic was routed, and what are the failure reasons. This can
help the user determine whether the network has graph connectivity between the source
and destination nodes. Again, this report is hyperlinked to help the user easily determine
the configuration of the devices involved with the traffic instance.

OPNET Technologies, Inc.
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Figure 23: Capacity Planning Traffic Route Report

The Residual Bandwidth Report is another section inside the Capacity Planning web
report. Similar to the Link Utilization Report, this section can be accessed by clicking
on the hyperlink located on the left side of the Capacity Planning report. The Residual
Bandwidth Report provides the ability to look at the remaining bandwidth for both
directions (forward and reverse) on a particular link. This report takes the total
bandwidth of the link and subtracts the bandwidth out of the link which was used by the
traffic defined in the scenario. This can help the user determine the amount of bandwidth
available, and whether traffic should be added or subtracted from the link. The report can
also assist in checking whether valid backup routes are available in the scenario. Again,
this report is hyperlinked to help the user easily determine the devices and links involved
in the report and to check the configuration of these objects. Note that the rows in the
report are color-coded to represent the percentage of bandwidth used on the link (blue is
zero, green is low, yellow is medium, and red is high).
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Figure 24: Capacity Planning Residual Bandwidth Report

Finally, the Circuit Switch Link Report is another section inside the Capacity Planning
web report. Similar to the Link Utilization Report, this section can be accessed by
clicking on the hyperlink located on the left side of the Capacity Planning report. The
Circuit Switch Link Report provides the ability to look at the Circuit Switch links inside
the scenario. This report allows the user to see the amount of utilization on the link, the
average utilization on the voice channel, and the number and size of the voice channels
on the link. This can help the user determine how well the circuit switch links and voice
channels are utilized in the scenario. Again, this report is hyperlinked to help the user
easily determine the devices and links involved in the report and to check the
configuration of these objects. Note that the rows in the report are color-coded to
represent the utilization of the link (blue is zero, green is low, yellow is medium, and red
is high utilization).
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Figure 25: Capacity Planning Circuit Switch Link Report

3.2 Discrete Event Simulation Statistics

The Discrete Event Simulation (DES) allows you to simulate the performance of a
network in detail by actually sending packets and data across a created NETWARS
scenario. The statistics gathered during this simulation allow you to gain specific details
about how a network and particular devices are performing. This information provides
you with a widespread picture of the simulated network and allows you to perform a wide
variety of studies. The listed statistics below are the specific statistics available when
using the NETWARS Voice models. Many other DES statistics are available based on
the type of technologies deployed inside the scenario. However, as this document is
based purely on the Voice devices, the other available statistics are outside of the scope
of this document. Refer to the NETWARS and OPNET IT Guru standard documentation
for more details on other statistics.
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Voice DES global statistics refer to statistics that are defined on a global network level
basis. To define these type of statistics, right-click on the scenario workspace (not on a
device, link, etc.) and select the Choose Individual DES Statistics menu item. After the
Choose Results dialog box displays, navigate to the Global Statistics section. The
global statistics from this section which work with the VVoice models are shown below.
Note that other global statistics are available but the listed statistics are used purely with

the Voice models.

Table 12: DES Voice Global Statistics

Statistic

Description

H323.Setup Time

This statistic holds the average setup time (in seconds) for all
H.323 calls in the network.

H323.Total Calls

This statistic holds the total number of H.323 calls signaled in
the network during a simulation.

H323.Total Failed Calls

This statistic holds the total number of H.323 calls in the
network which had a signaling failure during simulation.

H323.Total Successful Calls

This statistic holds the total number of H.323 calls in the
network which were signaled successfully during a simulation.

SIP.Call Setup Time (sec)

This statistic holds the average setup time (in seconds) for all
SIP calls in the network.

SIP.Calls Rejected

This statistic holds the total number of rejected SIP calls in the
network.

Total Voice Traffic.Blocking Probability

This statistic specifies the probability that a VVoice IER was
blocked in the network. A blocked IER means that no device
was available to accept the particular IER traffic at the start
time and it must be retried at a later time.

Total Voice Traffic.Call Completion Rate

This statistic specifies the probability that a Voice call is
completed on the network. A completed Voice call means that
the initial call setup occurred and all data was sent for the
duration of the call.

Total Voice Traffic.Connection Latency

This statistic specifies the average amount of time (in seconds)
that a Voice call requires to initially setup in the network.

Total Voice Traffic.End to End Delay

This statistic specifies the average amount of delay (in
seconds) for a VVoice packet to reach the destination in the
network. This is based off the sent time of the IER (i.e., when
the IER was sent to the device).

Total Voice Traffic.Grade of Service

This statistic specifies the percentage that a VVoice call was
able to be sent onto the network (i.e., it did not perish).

Total Voice Traffic.IER Failed Count

This statistic specifies the total number of failed Voice calls
(IERSs) in the network. Failed Voice calls are calls which
could not be setup or complete inside the network.

Total Voice Traffic.IER Perished Count

This statistic specifies the total number of perished Voice calls
(IERs) in the network. A perished Voice call occurs when the
IER is continually blocked until the specified perish time has
been reached for the IER. This means that the IER was unable
to be sent in a reasonable amount of time (as specified by the
IER definition).

Total Voice Traffic.IER Sent Count

This statistic specifies the total number of sent Voice calls
(IERs) in the network. A sent call occurs when the IER is
started on a particular device (i.e., it was not blocked) and
setup begins.

Total Voice Traffic.Message Completion

This statistic specifies the total number of completed Voice
calls (IERs) in the network. A completed Voice call means

OPNET Technologies, Inc.

40



that the initial call setup occurred and all data was sent for the
duration of the call.

Total Voice Traffic.Speed of Service

This statistic specifies the average amount of delay (in
seconds) for a Voice packet to reach the destination in the
network. This is based off the start time of the IER (i.e., when
the call signaling was started on the device).

Total VTC Traffic.Blocking Probability

This statistic specifies the probability that a VTC IER was
blocked in the network. A blocked IER means that no device
was available to accept the particular IER traffic at the start
time and it must be retried at a later time.

Total VTC Traffic.Call Completion Rate

This statistic specifies the probability that a VTC call is
completed on the network. A completed VTC call means that
the initial call setup occurred and all data was sent for the
duration of the call.

Total VTC Traffic.Connection Latency

This statistic specifies the average amount of time (in seconds)
that a VTC call requires to initially setup in the network.

Total VTC Traffic.End to End Delay

This statistic specifies the average amount of delay (in
seconds) for a VTC packet to reach the destination in the
network. This is based off the sent time of the IER (i.e., when
the IER was sent to the device).

Total VTC Traffic.Grade of Service

This statistic specifies the percentage that a VTC call was able
to be sent onto the network (i.e., it did not perish).

Total VTC Traffic.IER Failed Count

This statistic specifies the total number of failed VTC calls
(IERS) in the network. Failed VTC calls are calls which could
not be setup or complete inside the network.

Total VTC Traffic.IER Perished Count

This statistic specifies the total number of perished VTC calls
(IERSs) in the network. A perished VTC call occurs when the
IER is continually blocked until the specified perish time has
been reached for the IER. This means that the IER was unable
to be sent in a reasonable amount of time (as specified by the
IER definition).

Total VTC Traffic.IER Sent Count

This statistic specifies the total number of sent VTC calls
(IERs) in the network. A sent call occurs when the IER is
started on a particular device (i.e., it was not blocked) and
setup begins.

Total VTC Traffic.Message Completion

This statistic specifies the total number of completed VTC
calls (IERs) in the network. A completed VTC call means that
the initial call setup occurred and all data was sent for the
duration of the call.

Total VTC Traffic.Speed of Service

This statistic specifies the average amount of delay (in
seconds) for a VTC packet to reach the destination in the
network. This is based off the start time of the IER (i.e., when
the call signaling was started on the device).

Voice.litter (sec)

This statistic specifies the average difference in latency (in
seconds) between two packets on the network.

Voice.Packet Delay Variation

This statistic holds the variance among end-to-end delays for
voice packets. The end-to-end delay for a voice packet is
measured from the time it is created to the time it is received.

Voice.Packet End-to-End Delay (sec)

This statistic specifies the average amount of delay (in
seconds) for a VVoice packet to reach the destination in the
network.

Voice.Traffic Received (bytes/sec)

This statistic holds the average number of bytes per second
forwarded to all VVoice applications by the transport layers in
the network.

Voice.Traffic Received (packets/sec)

This statistic holds the average number of packets per second
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forwarded to all Voice applications by the transport layers in
the network.

Voice.Traffic Sent (bytes/sec)

This statistic holds the average number of bytes per second
submitted to the transport layers by all voice applications in
the network.

Voice.Traffic Sent (packets/sec)

This statistic holds the average number of packets per second
submitted to the transport layers by all voice applications in
the network.

Voice DES node statistics refer to statistics that are defined at the node level. To define
these type of statistics, right-click on the scenario workspace (not on a device, link, etc.)
and select the Choose Individual DES Statistics menu item. After the Choose Results
dialog box displays, navigate to the Node Statistics section. The selected statistics from
this section will then be collected for every device in the network which can write this
particular statistic. If the user wishes to specify statistics on a per-node basis instead, the
user should right-click directly on the device select Choose Individual DES Statistics.
The node statistics from this section which work with the VVoice models are shown below.
Note that other node statistics are available but the listed statistics are used purely with

the Voice models.

Table 13: DES Voice Node Statistics

Statistic

Description

H323.Active Calls

This statistic holds the number of active calls on this
H.323 device at a given time period.

H323.Setup Time

This statistic holds the average setup time (in seconds) for
a H.323 call on this node.

H323.Total Calls

This statistic holds the total number of H.323 calls
signaled on this node during a simulation.

H323.Total Failed Calls

This statistic holds the total number of H.323 calls on this
node which had a signaling failure during simulation.

H323.Total Successful Calls

This statistic holds the total number of H.323 calls on this
node which were signaled successfully during a
simulation.

SHOUTIp.Active Calls

This statistic holds the number of active calls on this
gateway at a given time period.

SHOUTIp.Total Calls

This statistic holds the total number of calls placed on this
gateway during a simulation.

SHOUTIp.Total Successful Calls

This statistic holds the total number of failed calls on this
gateway during a simulation.

SHOUTIp.Total Failed Calls

This statistic holds the total number of successful calls on
this gateway during a simulation.

SHOUTIp.Jitter (sec)

This statistic holds the jitter (in seconds) between the
previously received packet and the currently received
packet. Jitter refers to the difference in latency between
two packets.

SHOUTIp.Packet Delay (sec)

This statistic holds the average delay (in seconds) for each
packet received by this device.

SHOUTIp.Total Data Sent Over IP Network

This statistic holds the total amount of data sent over the
IP network by this gateway during a simulation.

SIP UAC.Active Calls

This statistic holds the number of SIP calls on this device
at a given time period.

SIP UAC.Call Duration (sec)

This statistic specifies the average duration (in seconds) of

OPNET Technologies, Inc.
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each SIP call on this device. Duration is defined as the
time which the node got call connect confirmation to the
time at which it got call disconnect confirmation.

SIP UAC.Call Setup Time (sec)

This statistic specifies the average time (in seconds)
needed to setup the SIP call.

SIP UAC.Calls Connected

This statistic specifies the total number of SIP calls
connected. This includes both calls initiated by this node
and any incoming call requests.

SIP UAC.Calls Initiated

This statistic specifies the total number of SIP calls
initiated at his node.

SIP UAC.Calls Rejected

This statistic specifies the total number of SIP calls
rejected on this device. This includes both calls initiated
by this node and any incoming call requests.

VolP Phone.Active Calls

This statistic holds the number of active calls on this
phone at a given time period.

VolP Phone.Total Calls

This statistic holds the total number of calls placed on this
phone during a simulation.

VolIP Phone.Successful Calls

This statistic holds the total number of successful calls on
this phone during a simulation.

VolP Phone.Failed Calls

This statistic holds the total number of failed calls on this
phone during a simulation.

VolIP Phone.Call Setup Time

This statistic holds the average time (in seconds) that calls
traversing this node take to setup properly (i.e., perform
the initial signaling).

VolIP Phone.Jitter (sec)

Statistic holds the jitter (in seconds) between the
previously received packet and the currently received
packet. Only available on the H.323 terminals.

VolIP Phone.Generated Phone Calls

Statistic holds the number of calls placed on this phone
where this phone is acting as the source (caller) phone.
Only available on the H.323 terminals.

VolP Phone.Received Phone Calls

Statistic holds the number of calls placed on this phone
where this phone is acting as the destination (callee)
phone. Only available on the H.323 terminals.

VolIP Phone.Packet Delay (sec)

Statistic holds the average delay (in seconds) for each
packet received by this device. Only available on the
H.323 terminals.

VoIP Phone.Total Data Sent Over IP Network

Statistic holds the total amount of data sent over the IP
network by this phone during a simulation. Only
available on the H.323 terminals.

Voice DES link statistics refer to statistics that are defined at the link level. To define
these type of statistics, right-click on the scenario workspace (not on a device, link, etc.)
and select the Choose Individual DES Statistics menu item. After the Choose Results
dialog box displays, navigate to the Link Statistics section. The selected statistics from
this section will then be collected for every link in the network which can write this
particular statistic. If the user wishes to specify statistics on a per-link basis instead, the
user should right-click directly on the link and select Choose Individual DES Statistics.
The link statistics from this section which work with the VVoice models are shown below.
Note that other link statistics are available but the listed statistics are used purely with the

Voice models.

Table 14: DES Voice Link Statistics
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3.3

3.4

Statistic Description

Voice Channels.Channel Utilization This statistic specifies the utilization for a Circuit Switch voice

channel inside the scenario. This is calculated by the voice
call bit rate divided by voice channel size.

DES Reporting Capabilities

In addition to the Discrete Event Simulation (DES) statistics, extra DES reporting
capabilities can be added to help the user obtains results. These reports allow the user to
access information which would otherwise be difficult to show statistically. Also, these
reports give the user an easy way to navigate through a large amount of information. As
part of the H.323 model suite, these reporting capabilities were developed and can be
accessed through the DES > Results > View Results... menu (after a Discrete Event
Simulation has been run). Please refer to the NETWARS H.323 Model User Guide for
further details.

Logical Views

Logical Views provide the ability to filter the network so that the user can look at
particular layers or technologies more closely. In the case of VVoice devices, the user
should use the IP and Voice layers. This layer can be located under the Network Layer
Filters section of the logical links dialog box. Secondly, the user can utilize the
Complete Network layer with VVoice devices. Note that the logical links functionality

can be found under the View > Show Logical Views... menu (dialog box shown below).

x
— Metwork Layer Filters ———— — Security Classification Filters ]
Fl'echnology Security Clagsification :l

[F =]
L i I
Service INew LI
 Link 16
NPG |Iew =
Met D INew ﬂ
" Tactical Radio
" Transmission Systems -
" Complete Metwork I LI _bl—l

— Time
Diuration: |3BDU ISEC(S) LI
Start Time: IU Hour(s) IU hdin(s) IU Secls)
[~ Consider Link Capacities
Help | Create View I Save Settings | Close

Figure 26: Logical View Dialog Box

OPNET Technologies, Inc.
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Once an IP logical view of the Voice devices is created, the user is able to see a graphical
representation of the IP connectivity of the VVoice devices inside the scenario. The figure
provided below shows the IP connectivity of the example project above. In the case of
Voice devices, the user should expect to see the connectivity between the VVolP
technology devices. Using the example project, the user will see that most of the devices
located inside the “VolP_Network” OPFAC are displayed below.

Network Showcase: Logical ¥iew (IP Technology) = I O |i|

WwoIP_Phone_1

o~

WoIP_Phone_2

£ Fouter F

Cisco 4300_3 Cisco 4500_2

SHOUTip

Close

Figure 27: IP Technology Logical View Example

Once a Voice logical view of the Voice devices is created, the user is able to see a
graphical representation of the Circuit Switch connectivity of the VVoice devices inside the
scenario. The figure provided below shows the Circuit Switch connectivity of the
example project above. Using the example project, the user will see that most of the
devices located inside the “Circuit_Switch_Network” OPFAC are displayed below.

It is important to note the orange, logical link which is displayed between the two LEN
devices. In the example case, this logical link is abstracting the layer-2 Promina
connection which sits between these two devices. What this link shows to the user is that
these two LEN devices can “talk” to each other using the Circuit Switch technology even
though they are not physically connected to each other. To find more information about
the Logical Link, right-click on the link and select Edit Attributes. This will show
information such as the physical links which make up the connection, the date rate, etc.
Note that Logical Links can occur in the other Logical View filters to abstract
technologies which are not relevant to the filter technology.
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Netwnrk Showcase: Logical Yiew (¥oice Technology)1

%

Figure 28: Voice Technology Logical View Example

Once a Complete Network logical view of the VVoice devices is created, the user is able

to see a graphical representation of the entire network without OPFACs or Organizations.

Essentially, this is the network shown with physical connections only. The figure
provided below shows the network connectivity of the example project above. Note that
the red link shown between the Promina devices is the Promina circuit object.

OPNET Technologies, Inc.
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3.5

Figure 29: Complete Network Logical View Example

To view more information on the Logical Views functionality, refer to the NETWARS
User’s Manual for more details.

Example Equipment Strings

Equipment strings are combinations of connected devices which can typically be found
inside a network. The below equipment strings should be considered as normal use cases
for the Voice devices and are supported by NETWARS. Note that arrows denote links
inside the network.

This document does not show the equipment strings related to H.323 and SIP setups. For
exact specifications on how to setup these types of networks, consult the H.323 or SIP
documentation.

Any additional equipment strings not shown could still be supported by the Voice
models.
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Circuit Switch
Phone

Circuit Switch
Phone

Figure 30: Circuit Switch Phone to Circuit Switch Phone Equipment String

VolP Phone VolP Phone

ﬁg
Figure 31: VolP Phone to VolP Phone Equipment String

=

MCU
VTC Terminal

N\

VTC Terminal VTC Terminal

Figure 32: VTC Equipment String

OPNET Technologies, Inc.
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Gateway
L
VoIP Phone Circuit Switch
Phone
Figure 33: VolIP to Circuit Switch Equipment String
Promina
Promina WAN Promina
LAN-side LAN-side
L L
m| > > im
Circuit Circuit
Switch/VTC Switch/VTC
Terminal Figure 34: Circuit Switch with Promina Equipment String Terminal
Secure
Encryptor Data Encryptor
x Non-secure

]

I

Switch/VTC
Terminal Figure 35: Circuit Switch with Encryptors Equipment String

Non-secure
Circuit Circuit
Switch/VTC
Terminal
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P
CTP/SCREAM Network CTP/SCREAM

ﬁ 7| > > ';'
Circuit Circuit

L
L
Switch/VTC Switch/VTC
Terminal Figure 36: Circuit Switch with CTP Devices Equipment String Terminal
Radio Link
TRC-170 [) € ¥ [ TRC-170
BEB HER
Circuit Circuit
Switch/VTC Switch/VTC
Terminal Figure 37: Circuit Switch with TRC-170 Equipment String Terminal

3.6 Traffic Usage

Depending on the Voice technology, different traffic types are available. The Circuit
Switch and VTC models work strictly with NETWARS IER traffic. The VolP models
work with both NETWARS IERs and standard OPNET traffic (Applications, Flows,
ACE, etc.).

3.7 Usage in Modeler

Currently, the NETWARS Circuit Switch and VTC models cannot easily be imported
into OPNET Modeler. This is due to the heavy reliance upon the NETWARS IER traffic.
For these types of models, the user would need to remove all of the NETWARS IER
references inside the model code and replace the IER code with a standard OPNET
traffic. Once this step is performed, the user could then import the models into OPNET
Modeler successfully by adding them into the mod_dirs model directories (accessible in
the Edit > Preferences menu).

For the VolIP models, these models can easily be imported into OPNET Modeler. Please
refer to the H.323 Models User’s Guide for information on how to import these models.

OPNET Technologies, Inc. 50
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4.1

41.1

Node Models

Architecture

The figure below shows the node models for the VVoice devices. These node models
provide an example of the full range of features available in the NETWARS Voice model
suite. The specific process models which make up the modules inside the node models
are out of scope for this document. However, all of the VVoice related devices and files
can be located under the <NETWARS Installation
Directory>\Sim_Domain\op_models\netwars_std_models \circuit_switch_voice and
<NETWARS Installation Directory>\Sim_Domain\op_models\netwars_std_models
\voip directories and sub-directories (where <NETWARS Installation Directory> is the
directory where NETWARS is installed). Note that all of the files and models in this
directory can be opened and modified using the OPNET Modeler software.

Circuit Switch Phone and VTC Node Models

The Circuit Switch Phone and VTC (VTC_Terminal and MCU) nodes represent the
endpoints where all calls can be initiated and received (i.e., the caller and callee). As
these terminals both work inside the Circuit Switch domain and are end stations, the node
models between these two devices are similar.

To perform the designated functionality, a “se” module is added on top of Circuit Switch
interfaces to create the complete node design. This application layer module will provide
the Circuit Switch Voice functionality by allowing the user to specify voice calls between
end terminals. All voice IERs sent to these terminals from the overlying “OE” node will
be received by the “se” module and translated into actual VVoice traffic by the cs_voice_se
process. This functionality includes using the Flood Search Routing protocol for call
setup and signaling, as well as, reserving the necessary bandwidth on the Phone Switch
link connecting to the border Circuit Switch device.

Note that OPNET traffic (i.e., Applications and Flows) are not supported on these end
devices.

A single Phone Switch interface has been added to give the terminals access to the
Circuit Switch network. The Phone Switch interface is a special interface which is used
only by end stations inside the Circuit Switch network. It essentially stands for the link
which connects the phone and the first border circuit switch device (i.e., a circuit switch).
This port can be recognized by the “pr_#_se_transmitter” name given to the transmitter
module and the “pr_#_se_receiver” name given to the receiver module.
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Node Model: dnvt

Node Model: cs_end_device_base
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Figure 39: VTC Terminal and MCU Node Model

OPNET Technologies, Inc.
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4.1.2 Circuit Switch Devices Node Models

The Circuit Switch Device nodes (i.e., LEN, SEN, TTC-39, etc.) represent the circuit
switches inside the Circuit Switch network. These switches forward the necessary
signaling and data across the Circuit Switch network and reserve bandwidth on the links
connected to them. As these devices all accomplish the same tasks, their node models are
similar with the main difference being the number of ports each device contains. An
example LEN node model is shown below.

To perform the designated functionality, “mux” and “circuit switch” modules are added
next to the Phone Switch and Circuit Switch interfaces to create the complete node
design. The “mux” module (which includes the mux process) is responsible for sending
the packets received from the Phone Switch interfaces and passing them to the “circuit
switch” module. It is also responsible for sending hello packets out on the Circuit Switch
interfaces on regular intervals. Hello packets allow the different switches to check for
network failure. If a hello packet is not received by a neighboring device within a certain
time frame, that neighboring device and route is marked as failed. All calls which would
use that particular route are also failed.

The “circuit switch” module (including the circuit_switch and flood_search_routing
processes) is responsible for most of the Circuit Switch device behavior. The module
performs all of the dynamic Flood Search Routing protocol signaling, as well as,
reserving the bandwidth on the connected Circuit Switch links.

Several Phone Switch interfaces have been added to allow the Circuit Switch devices the
ability to connect to Circuit Switch or VTC end stations. The Phone Switch interface is a
special interface which is used only by end stations inside the Circuit Switch network. It
essentially stands for the link which connects the phone and the Circuit Switch device.
This port can be recognized by the “dtg_pt_#” name given to the transmitter module and
the “dtg_pr_#" name given to the receiver module.

Several Circuit Switch interfaces have been added to allow the Circuit Switch devices to
connect to each other, as well as, other types of devices which can support Circuit Switch
(such as the Voice Gateway, Promina, Encryptors, TRC-170 radios, etc.). This port can
be recognized by the “ckt_pt_#” name given to the transmitter module and the
“ckt_pr_#” name given to the receiver module.
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Figure 40: Circuit Switch Device Node Model

4.1.3 VolP Phone Node Model

The VolIP Phone node represents the endpoint where all calls can be initiated and
received (i.e., the caller and callee). Currently, this phone supports both SIP and H.323
signaling and allows the user to toggle between these different signaling protocols using
the “Phone VolIP Protocol” attribute. The SIP protocol for this phone will remain as the
default but H.323 will now be available.

To perform the designated functionality, both a “se” and *“application” module are added
to the standard OPNET IP stack to create the complete VVoIP Phone node. These two
application layer modules will provide the call signaling (H.323 and SIP) functionality by
allowing the user to specify voice calls between end terminals. Also, these modules are
responsible for creating the necessary data packets which will load the network for the
duration of the call.

The “se” module is responsible for interacting with the standard NETWARS IER
structure. All voice IERs sent to the VVoIP Phone from the overlying “OE” node will be
received by the “se” module and translated into actual voice traffic. This translation is
performed by the voip_se process which can provide H.323 or SIP functionality by
interfacing with its H.323 or SIP child processes.

OPNET Technologies, Inc.
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The “application” module (including the gna_clsvr_mgr process) is provided to interface
with the standard OPNET application framework. Support currently exists for VolP
applications inside the standard OPNET library which can use SIP signaling only (H.323
support will be added in OPNET version 14.5). This workflow allows the “application”
module to translate any application definitions into realistic voice traffic. This is
performed by the gna_clsvr_mgr process which interfaces with the h323_mgr and
sip_UAC child process models (similar to the “se” module) to perform the necessary
VolP Phone signaling and functionality.

A single 10/100Mbps Ethernet interface has been added to the standard NETWARS IP
stack to give the VVolP Phone access to the IP network. This port can be recognized by
the “eth_tx_# #” name given to the transmitter module and the “eth_rx_# #” name given
to the receiver module.

Node Model: ¥oIP_Phone - | O Iil

File Edit Intetfaces Objecks ‘Windows Help

EErE L EEEEEEEE L

B
|

eth_r_0_0 eth_tx_0_0

Figure 41: VolP Phone Node Model
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4.1.4 Voice Gateway Node Model

The Voice Gateway provides the ability to convert VolP Voice calls into non-VolP
standard voice calls (and vice versa). This includes SIP to Circuit Switch, H.323 to
Circuit Switch, Circuit Switch to SIP, Circuit Switch to H.323, and H.323 to SIP
conversions. The Voice Gateway design will use the Media Gateway and SHOUTip
devices (NETWARS 2007 enhancements) as the base models. Note that the Gateway can
only interface with the NETWARS circuit switch devices and IER traffic. OPNET
applications will not be supported through the Gateway as NETWARS Circuit Switch
devices currently do not support OPNET applications.

The Media Gateway and N.E.T. SHOUT ip devices contain many different types of
functionality including VolIP (SIP and H.323) and SAToP support. Due to scope, this
document will only reference the VVoIP portions of these devices. Essentially, the VolP
portion of the Media Gateway and SHOUTip devices include the nw_voice_dispatch
process. This process provides the necessary SIP/H.323 functionality by interfacing with
the h323_mgr, sip_UAC, and sip_UAS child processes. Special care must be taken by the
Voice Gateway as it can act as both a client (i.e., terminal/endpoint for Circuit Switch
phones) for a call and as an H.323 Gatekeeper and/or SIP Proxy. Because of this, the
nw_voice_dispatch parent process must signal the child processes based on the actions
required by the received call.

All “circuit switch” voice interfaces (labeled cs_pt_#7) are directly sent into the
“voice_dispatch” module. This module either forwards the voice data to the VoIP
protocol (i.e., H.323/SIP) to be translated appropriately or sent back to another “circuit
switch” interface. Secondly, dual 10/100Mbps Ethernet interfaces (labeled eth_pt_# #”)
have been added to the standard NETWARS IP stack to give the Voice Gateway access
to the IP network. Finally, dual ATM interfaces (labeled atm_pt_# #”) have been added
to the standard NETWARS ATM/IP stack to give the Gateway access to ATM networks.
Note that ATM interfaces are only available on the Media Gateway device and not on the
N.E.T. SHOUTIp device.

The remaining circuit interfaces (labeled “cir_intf_#") are out of scope for this document.
These interfaces provide the necessary SAToP functionality for the N.E.T. SHOUTip
device only. Please refer to the NETWARS CTP Model User Guide for further details.
Essentially, this functionality works similar to the Juniper CTP model.

OPNET Technologies, Inc.
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Figure 42: SHOUTip Node Model
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Figure 43: Media Gateway Node Model

4.2 Device Creator

Currently, there is no device creator support with the Voice models in NETWARS.

OPNET Technologies, Inc.
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